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Development Milestones  
in a Child

Development milestones are a set of functional 
skills or age-specific tasks that most children can do 
at a certain age. These milestones help the teacher 
identify and understand how children differ in 
different age groups.

Age
5 - 8 Years

Physical

Language

Cognitive

Emotional/
Social

•	 First permanent tooth erupts
•	 Shows mature throwing and catching patterns
•	 Writing is now smaller and more readable
•	 Drawings are now more detailed, organised and have a sense of depth

•	 Vocabulary reaches about 10,000 words
•	 Vocabulary increases rapidly throughout middle childhood

•	 Attention continues to improve, becomes more selective and adaptable
•	 Recall, scripted memory, and auto-biographical memory improves
•	 Counts on and counts down, engaging in simple addition and subtraction
•	 Thoughts are now more logical

•	 Ability to predict and  interpret emotional reactions of others enhances
•	 Relies more on language to express empathy
•	 Self-conscious emotions of pride and guilt are governed by personal responsibility
•	 Attends to facial and situational cues in interpreting another’s feelings
•	 Peer interaction is now more prosocial, and physical aggression declines

If you cannot do great things, do small things in a great way.



Age 
9 - 11 Years

Age 
11 - 20 Years

Physical

Physical

Language

Cognitive

Cognitive

Emotional/
Social

Emotional/
Social

•	 Motor skills develop resulting in enhanced reflexes

•	 If a girl, reaches peak of growth spurt
•	 If a girl, motor performance gradually increases and then levels off
•	 If a boy, reaches peak and then completes growth spurt
•	 If a boy, motor performance increases dramatically

•	 Ability to use complex grammatical constructions enhances
•	 Conversational strategies are now more refined

•	 Applies several memory strategies at once
•	 Cognitive self-regulation is now improved

•	 Is now more self-conscious and self-focused
•	 Becomes a better everyday planner and decision maker

•	 Self-esteem tends to rise
•	 Peer groups emerge

•	 May show increased gender stereotyping of attitudes and behaviour
•	 May have a conventional moral orientation

Managing the children’s learning needs according to their developmental 
milestones is the key to a successful teaching-learning transaction in the 
classroom.

Family is the most important thing in the world.



Lesson Plans

Knowing yourself is the beginning of all wisdom.

Teaching Pedagogies

Pedagogy is often described as the approach 
to teaching. It is the study of teaching methods 
including the aims of education and the ways in 
which such goals can be achieved.

A lesson plan is the instructor’s road map which specifies what students need to learn and 
how it can be done effectively during the class time. A lesson plan helps teachers in the 
classroom by providing a detailed outline to follow in each class.

A lesson plan addresses and integrates three key components:

  Learning objectives

  Learning activities

  Assessment to check the student’s understanding

A lesson plan provides an outline of the teaching goals:

1.  Identify the learning objectives.
2.  Plan the lesson in an engaging and meaningful manner.
3.  Plan to assess student’s understanding.
4.  Plan for a lesson closure.

Present the lesson plan.

Reflect on what worked well and why. If needed, revise 
the lesson plan. 

Before the class

During the class

After the class



Teaching Objectives

By the end of this unit, students will be able to:
ªª Define communication and describe the communication process.
ªª Understand and apply the 7Cs of effective communication.
ªª Recognise various communication styles and methods.
ªª Improve public speaking and refusal skills.
ªª Understand basic grammar, sentence construction, and paragraph writing.
ªª Ask questions and describe daily routines using correct sentence structures.
ªª Apply assertive communication and non-verbal cues effectively.

Teaching Plan�

Number of Periods
Theory Practical

3 2

1.	 Introduction

	 Activities:

	 =	 Start with discussion questions:

		  ¡	 What is communication?

		  ¡	 Why is communication important in our personal and professional life?

		  ¡	 How do we communicate without words?

	 =	 Brainstorm examples of verbal, non-verbal, and visual communication.

2.	 Lesson Delivery

	 A.	 Understanding Communication

		  =	 Define communication and explain the communication process.

		  =	� Identify components: Sender, Message, Encoding, Channel, Receiver, Decoding, 
Feedback.

		  =	 Activity: Roleplay demonstrating each component using real-life examples.

Communication Skills-III1

If you have no confidence in self,  
you are twice defeated in the race of life.

Teaching Strategies

Numerous strategies have evolved over the years to facilitate the teaching-learning process 
in the classrooms.

Bloom’s Taxonomy

Bloom’s Taxonomy was created by Dr Benjamin Bloom and several of his colleagues, to 
promote higher forms of thinking in education instead of rote learning. There are three 
domains of learning: cognitive (mental), affective (emotional), and psychomotor (physical). 
However, when we refer to Bloom’s Taxonomy we speak of the cognitive domain. Bloom’s 
Taxonomy is a list of cognitive skills that is used by teachers to determine the level of 
thinking their students have achieved. As a teacher, one should attempt to move students 
up the taxonomy as they progress in their knowledge.

Teachers should focus on helping students to remember information before expecting 
them to understand it, helping them understand it before expecting them to apply it to a 
new situation, and so on.

Student 
Research

Small  
Group  
Work

Performance 
Activities

Direct 
Instruction

Problem 
Solving

Classroom 
Discussion

Cooperative 
Learning

Effective Teaching 
Strategies

Recall facts 
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concepts

Explain ideas 
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Use 
information 

in new 
situations, 
to answer 
questions 
or solve 
problems

Take apart 
information 

to show 
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causes and 
connections

Justify a 
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Produce 
something 
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Remembering
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LEVEL 1

LEVEL 2

LEVEL 3

LEVEL 4

LEVEL 5

LEVEL 6



7Web Applications (Ver. 2.0)-XI (Lesson Plan)

Lesson PlanCLASS 11

Teaching Objectives

By the end of this unit, students will be able to:
ªª Define communication and describe the communication process.
ªª Understand and apply the 7Cs of effective communication.
ªª Recognise various communication styles and methods.
ªª Improve public speaking and refusal skills.
ªª Understand basic grammar, sentence construction, and paragraph writing.
ªª Ask questions and describe daily routines using correct sentence structures.
ªª Apply assertive communication and non-verbal cues effectively.

Teaching Plan�

Number of Periods
Theory Practical

3 2

1.	 Introduction

	 Activities:

	 =	 Start with discussion questions:

		  ¡	 What is communication?

		  ¡	 Why is communication important in our personal and professional life?

		  ¡	 How do we communicate without words?

	 =	 Brainstorm examples of verbal, non-verbal, and visual communication.

2.	 Lesson Delivery

	 A.	 Understanding Communication

		  =	 Define communication and explain the communication process.

		  =	� Identify components: Sender, Message, Encoding, Channel, Receiver, Decoding, 
Feedback.

		  =	 Activity: Roleplay demonstrating each component using real-life examples.

Communication Skills-III1

Part-A: Employability Skills
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	 B.	 Communication Methods
		  =	 Verbal Communication: Oral and Written.
		  =	 Non-verbal Communication: Gestures, Posture, Facial Expressions.
		  =	 Visual Communication: Images, Signs, Charts.
		  =	 Group Task: Students categorise communication types from daily life scenarios.
	 C.	 Barriers & Perspectives
		  =	 Discuss language, emotions, prejudice, environmental and cultural factors.
		  =	 Activity: Discuss case study of communication failure and how it could be avoided.
	 D.	 The 7Cs of Effective Communication
		  =	 Clear, Concise, Concrete, Correct, Coherent, Courteous, Complete.
		  =	 Task: Rewrite vague sentences using the 7Cs.
	 E.	 Communication Styles
		  =	 Passive, Aggressive, Passive-Aggressive, Assertive.
		  =	 Activity: Students act out scenes with different communication styles.
		  =	 Discussion: Why assertive style is most effective?
	 F.	 Public Speaking – 3Ps Model
		  =	 Prepare, Practise, Perform.
		  =	 Activity: Deliver 1-minute talks with feedback on clarity and confidence.
	 G.	 Saying ‘No’ – AEIOU Model
		  =	 Teach assertive refusal using Ask, Express, Inform, Offer, Understand.
		  =	 Roleplay: Saying No in challenging social situations.
	 H.	 Basics of Grammar & Writing
		  =	 Parts of Speech: Noun, Pronoun, Verb, Adjective, Adverb, etc.
		  =	 Sentence Construction: Subject, Verb, Object.
		  =	 Types of Sentences: Declarative, Interrogative, Imperative, Exclamatory.
		  =	 Paragraph Writing Structure: Topic Sentence, Supporting Details, Conclusion.
		  =	 Practice: Create short paragraphs and identify sentence types.
	 I.	 Asking Questions
		  =	 Open-ended vs Closed questions.
		  =	 Activity: Convert statements into questions, identify types.
	 J.	 Daily Routines, Greetings, Family Introduction
		  =	 Activity: Write your daily routine using frequency adverbs.
		  =	 Introduce yourself and your family using possessive adjectives.

Extension

Ask the students some oral questions based on this chapter.

Q.	 What are the main elements in the communication process?

Q.	 Can you name and explain any three barriers to effective communication?

Q.	 What are the 7Cs of communication and why are they important?

Q.	 How do verbal and non-verbal communication differ?

Q.	 What does the AEIOU model help us with?

Q.	 Can you describe a situation where you used assertive communication?

Evaluation

=	 Create a visual family tree and present to class.

=	 Play “Feelings Charades” to recognise non-verbal cues.

=	 Record a 1-minute speech using 3Ps technique and get peer feedback.

Summative Assessment

=	 Quiz on communication process, methods, barriers, and 7Cs.

=	 Written paragraph describing a day in your life using correct sentence structure.

Practical Assessment

=	 Deliver short speech (graded on clarity, confidence, and structure).

=	 Fill a mock form and introduce yourself.

Suggested Activity

=	 Debate: “Verbal vs Non-Verbal Communication – Which is More Powerful?”

=	 Group Presentation: Visual communication examples and their cultural significance.

=	 Creative Poster: 7Cs of Communication with examples.

Teaching Objectives

By the end of this unit, students will be able to:
ªª Understand the importance of knowing oneself (values, beliefs, strengths, and weaknesses).
ªª Explore identity, personal background, and self-reflection practices.
ªª Practise effective grooming and personal hygiene habits.
ªª Develop time management and goal-setting techniques using the SMART framework.

Self Management Skills-III2
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Extension

Ask the students some oral questions based on this chapter.

Q.	 What are the main elements in the communication process?

Q.	 Can you name and explain any three barriers to effective communication?

Q.	 What are the 7Cs of communication and why are they important?

Q.	 How do verbal and non-verbal communication differ?

Q.	 What does the AEIOU model help us with?

Q.	 Can you describe a situation where you used assertive communication?

Evaluation

=	 Create a visual family tree and present to class.

=	 Play “Feelings Charades” to recognise non-verbal cues.

=	 Record a 1-minute speech using 3Ps technique and get peer feedback.

Summative Assessment

=	 Quiz on communication process, methods, barriers, and 7Cs.

=	 Written paragraph describing a day in your life using correct sentence structure.

Practical Assessment

=	 Deliver short speech (graded on clarity, confidence, and structure).

=	 Fill a mock form and introduce yourself.

Suggested Activity

=	 Debate: “Verbal vs Non-Verbal Communication – Which is More Powerful?”

=	 Group Presentation: Visual communication examples and their cultural significance.

=	 Creative Poster: 7Cs of Communication with examples.

Teaching Objectives

By the end of this unit, students will be able to:
ªª Understand the importance of knowing oneself (values, beliefs, strengths, and weaknesses).
ªª Explore identity, personal background, and self-reflection practices.
ªª Practise effective grooming and personal hygiene habits.
ªª Develop time management and goal-setting techniques using the SMART framework.

Self Management Skills-III2
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ªª Identify and apply self-motivation strategies.
ªª Understand and demonstrate effective teamwork and networking skills.

Teaching Plan�
Number of Periods
Theory Practical

3 31.	 Introduction

	 Activities:

	 =	 Begin with the question: “What are you good at, and what do you enjoy doing?”

	 =	 Discussion: “Why do people behave differently in the same situation?”

	 =	 �Ice-breaker activity: “Strength and Weakness Wall” – Students anonymously post one 
strength and one weakness on the classroom wall.

2.	 Lesson Delivery

	 A.	 Knowing Yourself & Identity

		  =	 Define belief, values, likes/dislikes, opinions, and background.

		  =	 Explain the concept of identity and how self-awareness helps in decision making.

		  =	 Activity: Reflection worksheet – “Who am I?”

	 B.	 Strengths vs Weaknesses & Interests vs Abilities

		  =	 Discuss how to identify strengths and weaknesses using feedback and self-analysis.

		  =	 Clarify difference between interests and abilities.

		  =	 Group Task: Students list hobbies and rate themselves on ability vs interest.

	 C.	 Impressive Appearance & Grooming

		  =	 Explain the role of first impressions, body language, and personal grooming.

		  =	 Demonstrate: Grooming checklist (hair, dress, shoes, nails, etc.)

		  =	 Activity: “Dress for Occasion” roleplay: Which dress for which scenario?

	 D.	 Personal Hygiene & Handwashing Techniques

		  =	 Discuss importance of hygiene in health and social life.

		  =	 Demonstrate correct handwashing steps.

		  =	 Activity: Hygiene habit tracker for 1 week.

	 E. 	 Self-Exploration Approaches

		  =	 Formal Learning, Informal Learning, Career Counsellors, Self-Reflection, and Feedback.

		  =	 Activity: Create a mini-portfolio with reflections and skills learned from different sources.

	 F.	 Teamwork

		  =	 Define teamwork, team members, and benefits.

		  =	 Show video: “The Power of Teamwork”
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		  =	 Activity: Tower Challenge – build tallest structure using limited materials in groups.

	 G.	 Networking Skills & CONECT Model

		  =	 Explain networking, benefits and six steps of CONECT.

		  =	 Roleplay: Meet-and-greet scenario to practise CONECT steps.

	 H.	 Self-Motivation

		  =	 Define motivation and explain intrinsic vs extrinsic motivation with examples.

		  =	 Video Session: “How to stay self-motivated”

		  =	 Task: Create personal motivation collage or quote wall.

	 I.	 Goal Setting & SMART Goals

		  =	 Explain SMART goals with examples.

		  =	 Activity: Students create one SMART goal for academic and one for personal life.

	 J.	 Time Management

		  =	 Importance of time and how to plan efficiently.

		  =	 Introduce daily planner, to-do list, and prioritisation.

		  =	 Activity: “Time Log” – Track daily time usage and reflect on improvement areas.

Extension

Ask the students some oral questions based on this chapter.

Q.	 What do you think makes you unique as a person?

Q.	 Can you describe the difference between interest and ability?

Q.	 Why is it important to maintain personal hygiene?

Q.	 How can SMART goals help in achieving success?

Q.	 What does self-motivation mean to you, and how do you practise it?

Q.	 Can you name any situation where teamwork helped you accomplish a task?

Evaluation

=	 Poster creation on Time Management Tips or Self-Motivation Quotes.

=	 Group presentation: Role of grooming and hygiene in personality development.

=	 Debate: “Hard Work vs Smart Work” or “Discipline vs Motivation.”

Summative Assessment

=	 Quiz: Types of motivation, CONECT model, hygiene steps.

=	 Short answers: Difference between interests & abilities, define identity, time management tips.
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Practical Assessment

=	 Presentation of personal goal plan and time log.
=	 Grooming demo and hygiene checklist submission.
=	 Team activity performance (graded on cooperation and participation).

Suggested Activity

=	 Create a “My Weekly Planner” chart and submit.
=	 Group Poster: “SMART Goals for Students”
=	 Self-reflection essay: “Three things I learnt about myself in this chapter.”

Teaching Objectives

By the end of this unit, students will be able to:
ªª Understand the purpose and advantages of using a word processor.
ªª Identify and use major components of the LibreOffice Writer interface.
ªª Format text using font styles, sizes, alignments, and text effects.
ªª Insert and manage lists, tables, pictures, shapes, headers, footers, and page numbers.
ªª Apply spell checking and grammar tools.
ªª Track and manage changes in a document.

Teaching Plan�

Number of Periods
Theory Practical

3 3
1.	 Introduction
	 Activities:
	 =	 Ask students: “Have you used a word processor before? For what purpose?”
	 =	 Display before/after samples of formatted and unformatted documents.
	 =	 Brainstorm how digital documents improve productivity.
2.	 Lesson Delivery
	 A.	 Introduction to Word Processing
		  =	 Define ICT and word processor.
		  =	 Discuss benefits: editing, formatting, saving, printing, visual enhancement.
		  =	 Activity: Create a basic document with a title and a paragraph.
	 B.	 Exploring LibreOffice Writer Interface
		  =	 Demonstrate Menu Bar, Toolbars, Zoom, and Status Bar.
		  =	 Activity: Identify elements in the Writer interface through worksheet.

ICT Skills-III3
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	 C.	 Creating and Managing Documents
		  =	 New, Save, Open, Close, Print, Print Preview.
		  =	 Shortcuts: Ctrl+N, Ctrl+S, Ctrl+P.
		  =	 Activity: Practice saving a document and using Print Preview.
	 D.	 Formatting Text
		  =	 Font style, size, bold, italics, underline, text alignment.
		  =	 Shortcuts: Ctrl+B, Ctrl+I, Ctrl+U.
		  =	 Activity: Format a given paragraph with specific text properties.
	 E.	 Editing Tools
		  =	 Cut, Copy, Paste, Find & Replace (Ctrl+X, Ctrl+C, Ctrl+V, Ctrl+H).
		  =	 Activity: Use Find & Replace to correct repeated spelling errors.
	 F.	 Spell Check & Grammar
		  =	 Use F7 or Shift+F7 to check document correctness.
		  =	 Demonstrate Auto Spell Check feature.
		  =	 Activity: Introduce errors and correct using spell checker.
	 G.	 Inserting Lists, Tables, Pictures, and Shapes
		  =	 Bulleted/Numbered lists: Format > Bullets and Numbering.
		  =	 Insert Table: Table > Insert Table / Ctrl+F12.
		  =	 Insert Image: Insert > Image.
		  =	 Insert Shapes: Drawing Toolbar > Shape.
		  =	 Activity: Create a formatted profile using a list, a table, and an image.
	 H.	 Adding Headers, Footers & Page Numbers
		  =	 Header/Footer: Insert > Header/Footer > Default Page Style.
		  =	 Add Date, Title, Page Number.
		  =	 Activity: Create a document with header/footer containing title and page numbers.
	 I.	 Tracking Changes in a Document
		  =	 Use: Edit > Track Changes > Record.
		  =	 Approve/Deny changes, Accept All/Deny All.
		  =	 Protect changes with password.
		  =	 Activity: Simulate a peer review using Track Changes.
	 J.	 Compare Documents
		  =	 Compare two versions of a document.
		  =	 Activity: Modify a peer’s document and compare with original.
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Extension

Ask the students some oral questions based on this chapter.

Q.	 What is the purpose of using a word processor?

Q.	 How do you use the ‘Track Changes’ feature in LibreOffice Writer?

Q.	 Which shortcut do you use to print a document?

Q.	 What are the steps to insert a table or image in a document?

Q.	 Why is formatting important in a document?

Q.	 Can you list three editing tools and their functions?

Evaluation

=	 Poster creation: “Advantages of Digital Documentation.”

=	 Debate: “LibreOffice Writer vs Google Docs.”

=	 Write an article, format, insert image, and save it.

Summative Assessment

=	 Quiz: Toolbars, shortcuts, menus, and functions.

=	 Written: Define word processor, tracking changes, spell checking tools.

Practical Assessment

=	� Students complete tasks: type, format, insert image and table, add header/footer, run spell check, 
and track changes.

=	 Peer document comparison and feedback session.

Suggested Activity

=	 Type and format an assigned paragraph.

=	 Create a birthday party invitation using Writer.

=	 Group Task: Create a school newsletter using various Writer features.

=	 Create a table-based student report card with styles and alignment.

Teaching Objectives

By the end of this unit, students will be able to:
ªª Define entrepreneurship and differentiate it from traditional business.
ªª Identify and explain types of business activities: manufacturing, trading, and services.

Entrepreneurial Skills-III4
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ªª Recognise values and attitudes essential for successful entrepreneurs.
ªª Demonstrate problem-solving techniques using creativity, innovation, and critical thinking.
ªª Generate and evaluate business ideas.
ªª Understand customer and market needs through surveys and competitor analysis.
ªª Explain the importance of a business plan and methods to improve business growth.

Teaching Plan�
Number of Periods
Theory Practical

4 21.	 Introduction

	 Activities:

	 =	 Ask students: “What comes to your mind when you hear the word ‘entrepreneur’?”

	 =	 Display stories of famous entrepreneurs and initiate a classroom discussion.

	 =	 Brainstorm: Why do some businesses succeed while others fail?

2.	 Lesson Delivery

	 A.	 Introduction to Entrepreneurship

		  =	 Define entrepreneurship with examples.

		  =	 Compare entrepreneur vs businessperson.

		  =	 Activity: Watch video “What is an Entrepreneur?” and answer guided questions.

	 B.	 Types of Business Activities

		  =	 Manufacturing, Trading, Services – with real-world examples.

		  =	 Case Study: Identify type of business from given scenarios.

	 C.	 Entrepreneurial Values

		  =	 Confidence, Independence, Perseverance, Open-mindedness.

		  =	 Activity: Value Identification from stories (e.g., Santosh and Asha).

		  =	 Group Task: Poster on “Values of a Successful Entrepreneur”.

	 D.	 Attitude of an Entrepreneur

		  =	 Belief in Self, Focus on Customer, Decision Making, Responsibility.

		  =	 Compare Entrepreneur vs Employee – Discuss attitudes.

		  =	 Roleplay: Entrepreneurial vs Employee responses to same scenario.

	 E.	 Problem-Solving in Entrepreneurship

		  =	 Define and explain problem-solving, creativity, innovation, and critical thinking.

		  =	 Task: Analyse a business problem and propose three solutions.

	 F.	 Generating a Business Idea

		  =	 Define a business idea and sources of idea generation.
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		  =	 Types: Location-based, Season-based, Event-based, Interest-based, Study-based.

		  =	 Activity: Think-Pair-Share – Generate a business idea and present.

	 G.	 Principles of Idea Creation

		  =	 Based on: Customer Need, Entrepreneur’s Interest, Innovation.

		  =	 Case Activity: Match principle with example.

	 H.	 Understanding the Market

		  =	 Customer Needs: Fulfilled, Partially Fulfilled, Unfulfilled, Unknown.

		  =	 Activity: Identify need type from sample scenarios.

	 I.	 Customer and Competitive Surveys

		  =	 Conducting customer and competitor surveys.

		  =	 Activity: Design a short customer survey and conduct a mock interview.

	 J.	 Business Planning & Growth

		  =	 Elements and importance of a business plan.

		  =	 Methods of Growth: Quality, Scale-up, Offers.

		  =	 Activity: Create a mini business plan with goals, team, and offerings.

Extension

Ask the students some oral questions based on this chapter.

Q.	 What is the difference between an entrepreneur and a businessperson?

Q.	 Can you name three values that every entrepreneur should have?

Q.	 What are the three main types of business activities?

Q.	 How can creativity help in solving a business problem?

Q.	 What is a business plan and why is it important?

Q.	 How can customer feedback help in improving a business idea?

Evaluation

=	 Interview a local entrepreneur and present their values and growth strategies.

=	 Group Discussion: “Are entrepreneurs born or made?”

=	 Create an elevator pitch for a new business idea.

Summative Assessment

=	 Quiz on entrepreneurship concepts, value traits, business planning.

=	 Short answers: Define entrepreneurship, value examples, problem-solving traits.

Practical Assessment

=	 Group business plan presentation.

=	 Survey development and roleplay feedback.

=	 Poster presentation of entrepreneur values.

Suggested Activity

=	 Prepare and present a business model canvas.

=	 Group competition: Build the most creative business idea from given materials.

=	 Write a reflection: “If I were an entrepreneur, I would…”

Teaching Objectives

By the end of this unit, students will be able to:
ªª Understand the concept and principles of the Green Economy.
ªª Identify various sectors contributing to the Green Economy.
ªª Recognise key policies and government initiatives that support green development.
ªª Understand the role of different stakeholders in achieving sustainability.
ªª Explore examples of Green Projects in India and apply these ideas to local contexts.

Teaching Plan�
Number of Periods
Theory Practical

3 21.	 Introduction

	 Activities:

	 =	 Ask: “What comes to mind when you hear ‘Green Economy’?”

	 =	 Watch introductory videos on Green Economy and Green Growth.

	 =	 Brainstorm real-world issues: pollution, climate change, resource depletion.

2.	 Lesson Delivery

	 A.	 What is Green Economy?

		  =	 Define Green Economy: low-carbon, resource-efficient, socially inclusive.

		  =	 Discuss economic and environmental aspects.

		  =	� Activity: Draw Green Economy triangle (Low Carbon + Resource Efficiency + Social 
Inclusivity).

	 B.	 Sectors of Green Economy

		  =	 Agriculture: Promote organic/local farming.

Green Skills-III5
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Practical Assessment

=	 Group business plan presentation.

=	 Survey development and roleplay feedback.

=	 Poster presentation of entrepreneur values.

Suggested Activity

=	 Prepare and present a business model canvas.

=	 Group competition: Build the most creative business idea from given materials.

=	 Write a reflection: “If I were an entrepreneur, I would…”

Teaching Objectives

By the end of this unit, students will be able to:
ªª Understand the concept and principles of the Green Economy.
ªª Identify various sectors contributing to the Green Economy.
ªª Recognise key policies and government initiatives that support green development.
ªª Understand the role of different stakeholders in achieving sustainability.
ªª Explore examples of Green Projects in India and apply these ideas to local contexts.

Teaching Plan�
Number of Periods
Theory Practical

3 21.	 Introduction

	 Activities:

	 =	 Ask: “What comes to mind when you hear ‘Green Economy’?”

	 =	 Watch introductory videos on Green Economy and Green Growth.

	 =	 Brainstorm real-world issues: pollution, climate change, resource depletion.

2.	 Lesson Delivery

	 A.	 What is Green Economy?

		  =	 Define Green Economy: low-carbon, resource-efficient, socially inclusive.

		  =	 Discuss economic and environmental aspects.

		  =	� Activity: Draw Green Economy triangle (Low Carbon + Resource Efficiency + Social 
Inclusivity).

	 B.	 Sectors of Green Economy

		  =	 Agriculture: Promote organic/local farming.

Green Skills-III5
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		  =	 Transport: Encourage electric vehicles, public transport.

		  =	 Water Management: Conservation and wastewater treatment.

		  =	 Waste Management: Reduce, reuse, recycle.

		  =	 Forestry: Prevent deforestation, promote sustainable forestry.

		  =	 Activity: Create posters for each sector with green solutions.

	 C.	 Green Economy Policies

		  =	 National Action Plan on Climate Change (NAPCC) and its 8 missions.

		  =	 Green India Mission, National Solar Mission, Swachh Bharat Abhiyan.

		  =	 Role of National Green Tribunal (NGT).

		  =	 Activity: Quiz on national missions and their objectives.

	 D.	 Stakeholders in Green Economy

		  =	 Government: Policies, enforcement, education.

		  =	 Private Sector: Business practices and compliance.

		  =	 NGOs, Farmers, Workers, Native Tribes, Scientists.

		  =	 Activity: Roleplay – simulate a Green Economy Town Hall with various stakeholders.

	 E.	 Government & Private Agency Functions

		  =	 Functions of Ministries: MoEFCC, Energy, Rural Development.

		  =	 Role of Private Agencies: Support, awareness, innovation.

		  =	 Activity: Debate – Government vs Private sector: Who should lead Green Initiatives?

	 F.	 Examples of Green Projects in India

		  =	 Mitticool clay refrigerator, Walkie-Talkie Charger, Windmill Tube Well.

		  =	 Liter of Light project, Banana Fibre Products.

		  =	 Activity: Group project – identify a local problem and propose a green solution.

Extension

Ask the students some oral questions based on this chapter.

Q.	 What is a Green Economy? Can you name its three key characteristics?

Q.	 Why is reducing carbon emissions important for sustainability?

Q.	 Can you name three sectors that contribute to the green economy?

Q.	 What is the function of the National Green Tribunal (NGT)?

Q.	 Give an example of a green project in India and describe its impact.

Q.	 How can individuals contribute to a greener environment in their daily life?
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Evaluation

=	 Research and present on Vandana Shiva and Ecofeminism.

=	 Design a green eco-cityscape poster.

=	 Investigate the Chipko Movement and similar environmental actions

Summative Assessment

=	 Quiz on definitions, national missions, roles of NGT and stakeholders.

=	 Written: Explain Green Economy, key projects, policies, and sectors.

Practical Assessment

=	 Create and present a group green solution plan.

=	 Mock interview/reporting of an environmental violation to the NGT.

Suggested Activity

=	 Poster on “Ways to Conserve Water” or “Say No to Plastic”.

=	 Create a local waste-to-product prototype.

=	 Group discussion: “Is the Green Economy the Future of India?”
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Lesson PlanCLASS 11

Teaching Objectives

By the end of this lesson, students will be able to:
ªª Understand the concept of computer networks and data communication.
ªª Explain the types of networks and network topologies.
ªª Identify and describe various network devices and transmission media.
ªª Explore web architecture, IP addressing, and protocols used in networking.
ªª Recognise network threats and the importance of cybersecurity measures.

Teaching Plan�
Number of Periods
Theory Practical

3 2Introduction

=	 Question-Based Discussion: Start the lesson by asking students:

	 ¡	 What do you think happens when you send a message on WhatsApp?

	 ¡	 Can you identify devices connected to the internet at your home or school?

	 ¡	 What is the role of a router or Wi-Fi in communication?

=	� Relatable Analogy: Compare a computer network to a postal system, where computers are 
homes, data is letters, and the internet is the road connecting them.

Lesson Delivery

1.	 Understanding Computer Networks and Communication

	 Explain the concept of communication:

	 =	 Sender, receiver, message, transmission medium, protocol.

	 Discuss what a network is:

	 =	 Types: PAN, LAN, MAN, WAN.

	 Activity:

	 =	 Ask students to sketch a basic home or school network with labelled devices.

Basics of Networking1

Part-B: Subject Specific Skills
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2.	 Transmission Media and Network Topologies

	 Introduce transmission media:

	 =	 Guided (twisted pair, coaxial, fibre optics).

	 =	 Unguided (radio waves, microwave, infrared).

	 Explain network topologies:

	 =	 Bus, Ring, Star, Mesh, Tree.

	 Activity:

	 =	 Use wires and labels to model different topologies in class.

3.	 Networking Devices

	 Describe functions of:

	 =	 Hub, Switch, Router, Repeater, Modem, Gateway, NIC.

	 Activity:

	 =	 Matching game: Match devices to their functions and icons.

4.	 Web Architecture and Protocols

	 Introduce Web Architectures:

	 =	 Client-server, P2P, three-tier.

	 Discuss key protocols:

	 =	 TCP/IP, HTTP, HTTPS, FTP, SMTP, POP3.

	 Activity:

	 =	 Students roleplay client-server interaction using paper messages (Request/Response).

5.	 IP Address, DNS and Internet Evolution

	 Explain concepts:

	 =	 IP Address (IPv4/IPv6), MAC address, Domain Name System (DNS).

	 Discuss the evolution of the Internet:

	 =	 From ARPANET to modern Internet.

	 Activity:

	 =	 Conduct a live nslookup or ping command to demonstrate DNS resolution.

6.	 Network Threats and Cybersecurity Measures

	 Identify common threats:

	 =	 Virus, worms, phishing, spamming, eavesdropping.

	 Cybersecurity tools:

	 =	 Firewalls, antivirus, strong passwords, two-factor authentication.
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	 Activity:

	 =	 Group discussion: “How to stay safe while using public Wi-Fi?”

Extension

=	 What is the difference between a switch and a router?

=	 How is the internet different from a LAN?

=	 Why do we need IP addresses in communication?

Creative Task:

=	� Ask students to design a secure network for a school with 10 computers, showing topology, 
devices, and cybersecurity measures.

Evaluation

=	 Conduct a quiz on key concepts (network types, devices, protocols).

=	 Assign students to draw a network topology of their home Wi-Fi setup and label the components.

=	� Practical lab session: Simulate sending a message over LAN using two connected systems or 
online simulation tools.

Suggested Activity

=	� Students will work in groups to create a model of a school network using physical props (labelled 
cables, devices, switches).

=	 They will present how data moves through the network using different devices and topologies.

Teaching Objectives

By the end of this unit, students will be able to:
ªª Understand what a website is and identify its types.
ªª Write and save HTML files using basic structure and tags.
ªª Use HTML tags to format text, insert images, lists, audio, video, tables, and forms.
ªª Understand linking types in HTML and how to create internal/external links.
ªª Apply CSS for styling and layout using inline, internal, and external methods.
ªª Use selectors, box model, and colour codes in CSS.
ªª Recognise the role of DNS and how to publish a website.

Teaching Plan�

Number of Periods
Theory Practical

8 6

Website Building Using HTML and CSS2
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Introduction
=	 Question-Based Interaction:
	 ¡	 What happens behind the scenes when you open a website like google.com?
	 ¡	 Do you think a single person can make a website?
	 ¡	 What do you need to build a website?
=	 Hook:
	 ¡	� Show a simple webpage with heading and paragraph vs. a styled version with CSS to 

demonstrate transformation.
Lesson Delivery
1.	 Introduction to Websites and Development
	 =	 Website and its purpose (informational, educational, entertainment)
	 =	 Static vs Dynamic Websites
	 =	 Languages: HTML, CSS, JavaScript
	 Activity:
	 =	 Compare static and dynamic sites (e.g., Wikipedia vs. Flipkart)
2.	 HTML Basics
	 =	 Tags and attributes
	 =	 Structure of HTML document: <html>, <head>, <title>, <body>
	 =	 Editors: WYSIWYG vs. Text Editor
	 Hands-On:
	 =	 Create and open “First Web Page.html” using Notepad and browser
3.	 HTML Formatting Tags
	 =	 Headings, Paragraphs, Line Breaks, Horizontal Rule
	 =	 Subscript, Superscript, Font Tag
	 =	 Logical and Physical Tags
	 Activity:
	 =	 Format a short poem using heading, line breaks, colours
4.	 Lists in HTML
	 =	 Ordered List: <ol> and type, start attributes
	 =	 Unordered List: <ul> and type attribute

	 =	 Definition List: <dl>, <dt>, <dd>
	 Task:
	 =	 Create a recipe using <ol>, shopping list using <ul>, and glossary using <dl>
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5.	 HTML Linking and Multimedia

	 =	 Internal and External Links using <a>

	 =	 Email links: mailto:

	 =	 Images: <img> with src, alt, height, width, align

	 =	 Audio & Video: <audio>, <video> with controls, autoplay

	 Activity:

	 =	 Create a personal profile page with link to email and insert photo/audio

6.	 Tables in HTML

	 =	 <table>, <tr>, <td>, <th>, <caption>

	 =	 Attributes: border, bgcolor, cellpadding, cellspacing, rowspan, colspan

	 Task:

	 =	 Create a student marksheet table with coloured rows

7.	 HTML Forms

	 =	 <form> tag and attributes: action, method

	 =	 Input controls: text, password, radio, checkbox, file upload

	 =	 Submit & Reset buttons

	 Task:

	 =	 Build a Registration Form using all controls

8.	 Introduction to CSS

	 =	 CSS Purpose and Benefits

	 =	 Linking CSS: Inline, Internal, External

	 =	 Selectors: element, id, class, universal, descendant

	 Demo:

	 =	 Style headings and paragraphs with internal CSS in <style> tag

9.	 Advanced CSS Styling

	 =	 CSS Box Model: margin, border, padding, content

	 =	 Colour Codes: HEX, RGB

	 =	 Backgrounds, Fonts, Lists, Tables, Images

	 Activity:

	 =	 Use <div> and <span> with CSS to create styled sections

10.	DNS and Publishing a Website

	 =	 What is DNS and how domain names work

	 =	 Hosting a website (brief)

	 =	 Importance of naming files and folders correctly

Extension

1.	 What is the role of <body> tag?

2.	 What is the difference between <div> and <span>?

3.	 Why is CSS important in web development?

4.	 How does DNS help you access a website?

5.	 What is the difference between inline and external CSS?

Creative Activity:

=	� Students will create a 3-page mini personal website with internal navigation, multimedia, styled 
elements, and form.

Evaluation

=	 Quiz: Tags, attributes, CSS selectors, form elements

=	 Lab Activity: Build a bio page using HTML + CSS

=	 Written Questions:

	 ¡	 Short: Define HTML. Write one example of an ordered list.

	 ¡	 Long: Write HTML code for a form to collect feedback with at least 5 controls.

Suggested Activity

=	 Each student creates and present their website using projector.

Teaching Objectives

By the end of this lesson, students will be able to:
ªª Understand what multimedia design is and identify different media types.
ªª Define GIMP and explain its features and interface.
ªª Download, install, and launch GIMP on Windows/Linux.
ªª Use the GIMP Toolbox for image creation and editing.
ªª Apply paint tools, selection tools, and transformation tools on images.
ªª Work with layers, paths, and filters in GIMP.
ªª Perform colour corrections and apply effects using filters.
ªª Demonstrate basic image manipulation using GIMP.

Multimedia Design Using GIMP3
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	 =	 Hosting a website (brief)

	 =	 Importance of naming files and folders correctly

Extension

1.	 What is the role of <body> tag?

2.	 What is the difference between <div> and <span>?

3.	 Why is CSS important in web development?

4.	 How does DNS help you access a website?

5.	 What is the difference between inline and external CSS?

Creative Activity:

=	� Students will create a 3-page mini personal website with internal navigation, multimedia, styled 
elements, and form.

Evaluation

=	 Quiz: Tags, attributes, CSS selectors, form elements

=	 Lab Activity: Build a bio page using HTML + CSS

=	 Written Questions:

	 ¡	 Short: Define HTML. Write one example of an ordered list.

	 ¡	 Long: Write HTML code for a form to collect feedback with at least 5 controls.

Suggested Activity

=	 Each student creates and present their website using projector.

Teaching Objectives

By the end of this lesson, students will be able to:
ªª Understand what multimedia design is and identify different media types.
ªª Define GIMP and explain its features and interface.
ªª Download, install, and launch GIMP on Windows/Linux.
ªª Use the GIMP Toolbox for image creation and editing.
ªª Apply paint tools, selection tools, and transformation tools on images.
ªª Work with layers, paths, and filters in GIMP.
ªª Perform colour corrections and apply effects using filters.
ªª Demonstrate basic image manipulation using GIMP.

Multimedia Design Using GIMP3
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Teaching Plan�

Number of Periods
Theory Practical

6 5

Introduction

=	 Ask:

	 ¡	 How do designers create amazing posters or edit photos professionally?

	 ¡	� Have you used Canva or Photoshop before? What if there was a free tool that could do 
similar things?

=	 Hook:

	 ¡	� Show before-and-after image edits using GIMP and discuss the creative potential of open-
source tools.

Lesson Delivery

1.	 Introduction to Multimedia and GIMP

	 =	 Define multimedia and types: Text, Graphics, Audio, Video

	 =	 Introduction to GIMP: GNU Image Manipulation Program

	 =	 Open-source alternative to Photoshop

	 =	 GIMP Interface: Menu bar, Toolbox, Layers, Docks, Single/Multi-window mode

	 Activity:

	 =	 Watch video “What is Multimedia?” and identify real-world examples

2.	 Downloading, Installing and Launching GIMP

	 =	 Demonstrate installation steps for Windows/Linux

	 =	 How to start GIMP, view interface and workspace?

3.	 Creating and Opening Images

	 =	 Create a new image (Ctrl + N), set resolution, colour

	 =	 Open existing image (Ctrl + O)

	 =	 Save image in .xcf, export as .jpg, .png

4.	 Selection Tools and Working with Layers

	 =	 Rectangle, Ellipse, Free, Fuzzy, By Color, Foreground, Scissors

	 =	 Understanding layer palette, duplicating layers, visibility

	 =	 Selection operations: Replace, Add, Subtract, Intersection

	 =	 Invert selection, delete background, save selected part

	 Hands-on:

	 =	 Extract subject from background using Free Select & Invert
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5.	 Painting and Editing Tools

	 =	 Pencil, Paintbrush, Airbrush, Ink Tool

	 =	 Eraser, Gradient, Clone, Heal, Blur/Sharpen, Smudge

	 =	 Dodge/Burn tools

	 =	 Paint tool options: Size, Opacity, Hardness, Color

	 Activity:

	 =	 Draw a smiley face using paint tools and fill it with gradient colours

6.	 Colour Tools and Adjustments

	 =	 Foreground/Background, Color Picker

	 =	 Adjust: Brightness/Contrast, Hue/Saturation, Invert, Color Balance

	 Task:

	 =	 Change eye/hair colour in a photo using Colour and Paint tools

7.	 Text and Paths Tool

	 =	 Add and format text

	 =	 Use Path Tool to select irregular shapes

	 =	 Convert path to selection and paste in new file

	 Task:

	 =	 Add your name and outline text using Stroke method

8.	 Transform Tools

	 =	 Move, Rotate, Scale, Shear, Flip, Perspective, Unified Transform, Cage Transform

	 =	 Crop tool for resizing image

	 Activity:

	 =	 Flip and rotate an image, apply scale and crop

9.	 Filters and Effects

	 =	� Filters categories: Blur, Enhance, Distorts, Light & Shadow, Artistic, Noise, Map, Alpha to 
Logo

	 =	 Apply effects like Supernova, Drop Shadow, Emboss, Cartoon, Mosaic

	 Activity:

	 =	 Apply Artistic → Oilify filter to an image to convert it into a painting

10.	Preferences and Customisation

	 =	 Customise interface, shortcuts, themes, tool docks

	 =	 Using Edit → Preferences for workspace setup
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Extension

1.	 What is GIMP used for?

2.	 Name any three selection tools in GIMP.

3.	 What is the use of the Heal tool?

4.	 How can you change the colour of clothes using GIMP?

5.	 What are Layers in GIMP?

Creative Activity:

=	� Open an image, remove background using selection tools, and apply filters to create a new 
poster.

Evaluation

Ask students to do:

=	 MCQs and Fill in the blanks from the chapter.

=	� Short & long answer questions as well as competency-based question from the chapters back 
exercise.

Suggested Activity

Mini Project – Digital Collage in GIMP

=	 Students will create a digital poster by:

	 ¡	 Inserting multiple images		  ¡	 Removing background

	 ¡	 Using layers and filters		  ¡	 Adding text and applying effects

Teaching Objectives

By the end of this unit, students will be able to:
ªª Understand the role of JavaScript in web development.
ªª Explain the difference between static and dynamic websites.

ªª Write and execute JavaScript code using the <script> tag.
ªª Use data types, variables, operators, control structures, and loops.
ªª Interact with HTML through JavaScript using DOM.

ªª Handle user interactions via dialog boxes like alert(), prompt(), and confirm().
ªª �Perform type conversions, string operations, and mathematical calculations using built-in 

functions.

Introduction to JavaScript4
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Teaching Plan�

Number of Periods
Theory Practical

7 6

Introduction

=	 Warm-up Questions:

	 ¡	 What makes a website interactive?

	 ¡	 Have you ever clicked a button on a web page that changed text or showed a pop-up?

	 ¡	 Can HTML and CSS do this alone?

=	 Demo:

	 ¡	 Show a simple web page with and without JavaScript to illustrate the power of interactivity.

Lesson Delivery

1.	 Static vs Dynamic Websites

	 =	 Static websites: Hardcoded HTML content

	 =	 Dynamic websites: React to user input using JavaScript or server-side languages

	 Activity:

	 =	 Compare screenshots or live demos of both types of websites.

2.	 JavaScript Basics

	 =	 History, features, interpreted nature

	 =	 Advantages & disadvantages

	 Code Demo:

	 =	 Display alert(“Hello World!”) using internal and external JavaScript

3.	 Embedding JavaScript in HTML

	 =	 <script> tag usage in <head>, <body>, or external file

	 =	 Writing simple scripts with document.write(), alert(), console.log()

	 Activity:

	 =	 Create your first script to display name, date, and a welcome message.

4.	 JavaScript Syntax & Statements

	 =	 Case sensitivity, variables, literals, comments

	 =	 Operators: arithmetic, assignment, comparison, logical, bitwise, ternary

	 =	 Associativity & precedence

	 Task:

	 =	 Calculate expressions like (a += ++a + a-- % --a) and explain precedence
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5.	 Data Types and Type Conversion

	 =	 Primitive and non-primitive data types

	 =	 Implicit and explicit type conversion (e.g., Number(), String(), Boolean())

	 Hands-on:

	 =	 Try parseInt(), parseFloat(), and eval() using input strings

6.	 Dialog Boxes for Interaction

	 =	 alert(), prompt(), confirm() methods

	 =	 window object and its role

	 Activity:

	 =	 Build a script that asks user age and gives eligibility for licence

7.	 Control Structures

	 =	 Decision Making: if, else if, switch

	 =	 Loops: while, do...while, for

	 =	 Jump statements: break, continue

	 Task:

	 =	 Write a script to calculate the factorial of a number using loop

8.	 Working with the DOM

	 =	 What is DOM and how JavaScript manipulates it

	 =	 getElementById(), innerHTML, style, createElement(), appendChild()

	 Practical:

	 =	 Button to change text, add new element, or remove content dynamically

9.	 String and Math Operations

	 =	 length, substring(), search()

	 =	 Math.round(), Math.ceil(), Math.floor(), Math.trunc()

	 Task:

	 =	 Write a script to take a sentence and extract part of it using substring()

10.	Functions in JavaScript

	 =	 Built-in: isNaN(), parseInt(), valueOf()

	 =	 User-defined function syntax and usage

	 Activity:

	 =	 Create a reusable function to calculate area or interest
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Extension

1.	 Why is JavaScript called an interpreted language?

2.	 How is JavaScript different from HTML and CSS?

3.	 What is the use of the DOM in JavaScript?

4.	 Define prompt and confirm dialog boxes.

5.	 Explain parseInt() vs parseFloat().

Creative Activity:

=	 Create a small interactive quiz using prompt, if-else, and alert

=	 Design a form with validation using DOM and JavaScript

Evaluation

=	 MCQ & Fill in the blanks on data types, syntax, functions.

=	� Short & long answer questions as well as competency-based question from the chapters back 
exercise.

=	 Code Output Analysis: Predict the result of snippets using ++, ==, !=

=	 Lab Assignment:

	 ¡	 Build a page with two inputs and calculate:

		  <	 Area of a rectangle

		  <	 Simple interest

Suggested Activity

Mini Project – “My Profile Page”

=	 Collect user name using prompt()

=	 Display on page with styles using DOM

=	 Use confirm box before clearing the page


